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Creo is a world leader in solutions for the graphic arts industry. Core product lines include 
image capture systems; inkjet proofers; thermal imaging devices for films, plates and proofs; 
professional color and copydot scanning systems; creative workflow; and workflow 
management software. Creo is also an Original Equipment Manufacture supplier of on-press 
imaging technology, components for digital presses, and color servers for high-speed, print-on-
demand digital printers. Creo trades on NASDAQ (CREO) and the TSE (CRE). 

Note: This document contains information about the CXP3535 Color Server v1.0. Distribute a 
copy of this Release Notes document to all users and have the user read this document before 
using the CXP3535 Color Server. 
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Software KIT content 
 
The Software Kit includes 3 CDs with the following content: 

CD # 1:  
This CD contains the Windows 2000 Professional operating system with a customized menu for 
reinstalling the CXP3535 Color Server. 
 
Note: This version is enclosed with Internet Explorer 6.0 and Service Pack 3.0 
 

CD # 2:  
This CD contains the CXP3535 Multi-Lingual Application Software (Setup, PPD's, printer drivers 
and utilities). 
 

CD # 3:  
This CD contains the Utilities, the CXP3535 Installation Guide and the Printing Guide, and the 
customer Release Notes in PDF format in the following languages: English, French, German, 
Spanish, Italian, Portuguese and Dutch. 
 
The CD has both Macintosh and PC partitions so that it can be mounted on both platforms. The 
Installation Guide and Printing Guide can be inserted on any client computer with a CD-ROM 
drive and submitted for printing on any printer. They can also be submitted to print via the 
CXP3535 Color Server and printed on the DocuColor 3535. 

To print the CXP3535 Installation Guide and Printing Guide on a DocuColor 3535 using the 
CXP3535: 
1.  Insert the CXP3535 Color Server Documentation and Utilities CD #3 into the CXP3535’s 

CD-ROM drive while the CXP3535 application workspace is open. 
2.  From the File menu, select Import Job. 
3.  Browse to the CD-ROM and select the required document. 
4. Click Add to List. 

The file appears on the right side of the Import Job dialog box. 
5.  Click Submit.  

The selected document is submitted to the CXP3535 Color Server to be printed. 
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Installation Instructions 
Important Notice: 
The Spire Color Server is delivered with CXP3535 1.0 for DocuColor3535. 

To install the CXP3535 1.0 for DocuColor3535: 
1. Uninstall the current version.  
2. Reinstall the version by using CD#1, CD #2, CD #3. 

The CXP3535 application appears. 
3. From the Help menu, select About.  

The About window appears with the version information. 

 

This completes the installation of CXP3535 1.0 for DC3535. 
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CXP3535 Color Server Tips 

Antivirus software 
The CXP3535 Color Server was tested successfully with the McAfee Virus Scan version 7.0 - for 
Windows 2000 professional server. To limit degradation of performance, it is recommended to 
avoid auto scan mode and to activate the Anti Virus software only when the CXP3535 Color 
Server application is closed.  
Before installing the CXP3535 make sure all other applications are closed including Anti-virus 
applications. This application is not bundled With CXP3535 Application. 

Loading Software 
Do not load unauthorized software onto the CXP3535 Color Server system. 

Reinstalling the CXP3535 operating system 
When reinstalling the CXP3535 CD#1 (Windows 2000 fast install) use only the “Creo Software 
Complete Overwrite Installation” option. 

Add printers on client workstations 
It is recommended to use Adobe PS Driver utility from CD #3 to install printers on client 
workstations.  

Note: When updating or installing a new version, the old printers must be removed from the client 
workstation and new printers installed. 

DCS Format Support 
The CXP3535 can process input files with embedded DCS1 or DCS2 (PhotoShop) format files. 

DCS Printing Steps: 

• Place the DCS file in a DTP (Desk Top Publishing) Application such as QuarkXPress or 
Freehand. 

• Copy the DCS file to the CXP3535 Color Server High-Resolution folder (at D\Shared\High 
Res). 

• Set the PS Overprint option in the Print Quality Tab in Job Parameters or in PPD to Yes. 
• Print the file in composite mode. 

Note: A different path can be used for the high-resolution DCS files. When doing so make sure 
the path is added to the APR search paths (Services Tab of the Job Ticket). 

Driver and Application Collation Options 
Most printer drivers and MS Office applications support a Collate option. To receive properly 
collated or stapled output, disable the Collate feature in the print driver and in the application and 
enable the Collate feature in the PPD. 

Printing on Coated Paper 
When printing on coated paper, it is recommended to select the Saturated calibration table.  

Revert the system values for the Normal/saturated calibration tables 
If the Normal or saturated calibration tables were edited and you wish to revert to the system 
default calibration table, do the following: 
 
1. From the Tools Menu select Calibration. 

The calibration window appears  
2. From the calibration table name, select SpireNormal (or Spire Saturated calibration table) 
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3. Click the Edit button 
The Edit Calibration Window appears. 

4. Click the Save As button  
The Save As dialog box appears. 

5. In the file name text field type Normal (or saturated ). 
6. Click OK. 

The following message appears: “Calibration table already exists. Do you want to replace it “? 
7. Click Yes.  

File Name 
If the word "executive" is used in the file name, this may result in failure in the RIP process. 

CMYK Emulation 
The ICC profile names should not contain any spaces or the improper characters. Examples of 
improper characters include the following symbols: ! @ # $ % ^ & * ( ) - / ? > < ' " ; : ] [ { } \ 

Range printing with HCSS 
In duplex printing, use only continuous range printing, not non-continuous page printing, which 
requires a comma. 

Font Substitution 
In case when the DFE fails to substitute fonts and no fonts are printed in the output, turn Font 
Substitution Off in the virtual printer. 
Go to: Admin  Resource Manager  Virtual Printer 

Staple Feature Options 
A file with "Portrait" image orientation will also have Landscape staple options available. Choose 
the correct Staple orientation option according to its job image orientation. The image might be 
cropped when choosing a staple orientation different from the image orientation set by the 
application. 
 



 

Image size to trim size ratio in Imposition 
The ratio between image size and trim size in imposition setting should not be more than 3.0, 
otherwise job might fail in print. For example: do not place two Tabloid size images, trimmed to 
Letter size on a Tabloid size sheet. 

OS Set Up and Software Requirements  
The supported Macintosh OS is 8.51 and higher. The recommended print driver depends on the 
Macintosh OS that is being used. Unknown problems may occur if other drivers are used. 
MAC OS Recommended Print Driver  
8.51-8.xx LaserWriter 8.6.1 
9.0-9.x  LaserWriter 8.7 
Adobe PostScript Driver for Win NT/2000/XPis 5.2.1 and Win 98/ME is 4.5.1.  

Note: The CXP3535 does not require any driver installation for MAC OS 10.x. To print to the 
CXP3535 from MAC OS 10.x use the Print Center application Add Printer to add the virtual 
printer. 
Win NT/2000 clients may require login to the CXP3535 Color Server printers upon client reboot or 
when login as a different user. The default login name is “operator” and the password is “spire”. 

Admin Page 
The Color Server Name field on the Admin Page will print with the color server name from the 
Macintosh client workstations and the client workstation name from PC client workstations. 
The Sender Name field from the Macintosh OS 9.X clients will print with the Owner name. From 
OS X, the User Name will print in this field.  
Total number of printed sheets field relate to different imposition settings of the job. It does not 
relate to Print Range settings. 
Imposition using Fit to Page with Admin Page causes the Admin page image scaling to change. 
 
Admin Page is not available with Gallop printing mode. 
 
Admin Page is printed in English only. 

Text/Line Quality 
When jobs contain complicated graphic work (LW) and the Text Line Quality parameter (in the 
Job Parameters window) is set to High, the following message may appear: "Job <Job 
Name>cannot be processed with Text/Line Quality High. Change the Text/Line Quality parameter 
to Normal and resubmit the job".  

Print Grays Using K Toner 
When using this feature not only R=G=B values will be effected but also slightly different values 
(R+/-4=B+/-4=G+/-4) may produce gray. 

In order to have BW click charge for “Gray-CMYK Elements”: 
1. In the Administration window>preferences>color>emulation Select CSA emulation method 
2. Select the Print grays using K toner in the Job Parameters window. 
3. Select CMYK emulation. 
4. Select Perceptual or Saturated CMYK Rendering Intent in the Job Parameters window. 
5. Submit the job. 

 

Note: The “Print grays Using K toner” option will not affect CMYK elements when Device link 
emulation method is selected in the preferences. 

Thumbnail View 
The thumbnail view does not show the correct staple position.  
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System Disk C 
The user should not perform any actions on the Disk C. Any procedures performed by the user 
such as Archiving must be performed on Disk D. 

Calibration 
If grays colors appear "too warm" in the print output, use the gradation tool to adjust the colors 
and assign the new table for the specific job. 

Creo Spot Colors XT v2.3.1 
It is not recommended to work with Creo Spot Colors XT v2.3.1XTension when using Quark 
XPress. 

OPI 
When using APR on the CXP3535 Color Server make sure that the OPI XTension in Quark is not 
active or disable OPI Comments from the Spire preferences. 

Web Viewer 
To connect to the Spire from a Macintosh client workstation, use the IP Address of the CXP3535 
Color Server. The IP Address can be obtained from the DFE Monitor in the Network tab. 
 
The Web Viewer is applicable for Mac and PC platform and can be run only on Explorer 5.0 and 
higher browsers. 

Spire Printing Over TCP/IP from MAC 
The Spire Over TCP/IP connection enables Macintosh clients to print jobs to SPIRE over a 
TCP/IP protocol. This connection enables a significantly higher spooling speed. 
 
To set up TCP/IP printing from Mac download the Choose Spire Over IP installer from the 
CXP3535 Color Server D:\Utilities folder. For more information see the CXP3535 Color Server 
Installation Guide.  

Note: To enable the Spire Over TCP/IP connection, a Macintosh O/S version 8.6 or higher, with 
an installed LaserWriter application version 8.6 or higher, or AdobePS 8.8 or higher is required. If 
the user does not have a compatible LaserWriter application installed, the user may download 
this application from the CXP3535 Color Server, under D:\Utilities\Mac utilities folder. 

Scan Back 
The Spire Scan Back option enables the user to scan color and BW images off the  
IOT platen. Scanned jobs are stored on the Spire under D:\Scan To Spire shared directory. 
 
Color jobs can be found under D:\ScanToSpire\Spire_Color. 
BW jobs can be found under D:\ScanToSpire\Spire_BW. 
 
Color scanned jobs: A dedicated directory is created under Spire_Color for each scanned job. 
Directories are named SpireColor.XSM. When more than one scanned job exists on the system 
a sequential number suffix is added to the directory name.  
The scanned images of each job are saved under SpireColor.XSM as Jpeg files. If more than 
one image exists in the job a sequential number suffix is added to the file name. 
 
BW scanned jobs: The scanned images of each job are saved under Spire_BW as Tiff files. If 
more than one image exists in the job a sequential number suffix is added to the file name. 

Note: D:\ScanToSpire directory is shared as read only. It is the responsibility of the Spire 
operator to clean up old scan jobs and make sure that sufficient free disk space is available.  
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Finisher 
Two Finishing options are available for the user when a Finisher is part of the configuration: 
Finisher - Stacker 
Finisher – Stapler 
Selecting “Finisher – Stacker” will direct pages to the finisher for stacking without stapling. 
Selecting “Finisher – Stapler” will direct pages to the finisher for stacking with stapling. 

Note: When selecting “Finisher – Stacker” on the client PPD all stapling options are constrained. 

Face Up printing 
The CXP3535 supports Face Up printing for Duplex mode only. 
Although the DC3535 does not support Face Up delivery the CXP3535 supports Face Up printing 
by reversing the order of images on each duplex page. 

Manual Duplex 
Manual Duplex printing is supported on the CXP3535 from Tray 5 (bypass) only. It is aimed for 
special media/non standard sizes only. If a regular standard size media is fed from Tray 5 
(bypass) it will be printed with auto duplex mode. 

Auto Gradation Adjustment 
Auto Gradation Adjustment for printing mode is not supported by the CXP3535 v1.0. 

Jobs Archive and Retrieve 
When jobs are archived they do not retain their original status. Jobs are always retrieved to the 
Storage Folder with “Hold” status.  

CMYK Vignette 
In order to achieve best quality when printing CMYK vignettes that start\end with a pure black turn 
off the Device Link – Preserve Pure Colors option under Administration\Preferences\Color 
\Emulations 
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CXP3535 Color Server Limitations 

Merge RTP Jobs 
In merged jobs created in the Job Preview&Editor, job parameters that would require a re-RIP 
(For example: Color Emulation, Image Quality) should not be changed. 

Jpeg 
Progressives Jpeg is not supported 

Hot Folders  
Tiff/it can’t be imported to the Spire via Hot folder. 
Brisque jobs must be fully submitted under foldername.job. (Not only the assign file) 
Single pages of a Brisque job should be submitted under foldername.p 
In windows 98 the printer name must be less than 9 characters; otherwise the Hot Folder 
name/icon is not displayed.  
In windows ME the printer name must be less than 12 characters; otherwise the Hot Folder 
name/icon is not displayed.  

Note: You may save these virtual printers under a shorter name and use their corresponding hot 
folders instead. 

Settings exceptions for imposed jobs 
When using the Step & Repeat template with the Cut & Stack sub option, the Exceptions tab is 
disabled. 
Paper size cannot be set as exception for imposed jobs. 
In order to print front or back covers in imposed jobs, do not use the front or back cover job 
parameters. Instead, use the Exceptions tab in the Job Parameters window, and specify sheet 
number one as an exception in the job 

Device Link 
Only CMYK Profiles can be imported to the Profile Manager (In the Resources Manager). If the 
imported profile is not a CMYK Profile the following message will be displayed: “Import failed 
because the file is not an output profile.” 

Imposed Sheet Range 
This feature is available only for Imposed RTP jobs: 
For Non VI Imposed RTP files, the methodology of print range will be changed to Imposed Sheet 
range. 
An exception: For Non VI S&R RTP files the methodology of print range will remain Page range 
(and not sheet range) 
For VI Imposed RTP files, the methodology of print range will be changed booklet range 
An exception: For VI Imposed RTP with Cut & Stack, Print range is disabled. 
Sheet refers to one side of the physical sheet. In case of duplex printing each sheet is counted 
twice (e.g. for sheet 1, Side A and side B) 

Image Noise 
Affects only CT elements. 

Split to booklets 
Available for Non VI jobs with number of pages >1 
Supports splitting only to equal number of pages per booklet.  
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Imposed Sheet View 
The imposed sheet tab is enabled only for Imposed RTP jobs 
If the user used Merged job for an Imposed RTP, Then in order to preview the new Imposed 
sheet view the Job should be saved FIRST (by using the save as button) and only then can be 
previewed (by using the Job preview & editor option) 

PPD 
The Spire PPD cannot constraint illegal programming based on Custom paper size and/or 
Number of pages (E.g., stapling is not allowed for jobs with more than 50 pages). PPD is not 
aware of custom sizes and jobs number of pages.  
In these cases illegal programming will be detected only after the job has spooled to the 
CXP3535 server. 

PPD in multiple languages 
Spire printers that were installed on client workstation prior to a language change on the Spire 
server, will present the English PPD. 

Novell Banner Page 
Banner page for Novell is not supported 

Image Scale  
The Image Scale feature cannot be operated with the PDF Optimization function. 
Selecting the Image Scale feature automatically disables the PDF optimization function. 

LPR Printing 
All LPR commands that are related to job programming such as print method, number of copies 
are not supported.  

Imposition S&R 5X2  
Crop marks are not added to a job with the following imposition setting: S&R, Portrait, 5x2 
Duplex. 

Image Scale  
The Image Scale feature does not support VI jobs and PDF Optimized jobs. 

Fit to Sheet Size in Imposition 
The Fit to Sheet Size feature in imposition does not support VI jobs. 
The Fit to Sheet Size in Imposition cannot be operated with PDF Optimization. 
If the Fit To Sheet Size option is selected in Imposition, the PDF Optimization will be disabled 
by default. 



12                                                                                                                  CXP3535 Version 1.0 for DC5252 

  

Variable Information (VI) 

VPS Process 
It is recommended to use Creo Darwin 4.5 or higher version. 
The DocuColor 3535 is capable of efficiently handling variable data jobs in segmented run 
lengths. Large complex jobs should always be segmented into smaller run lengths to achieve 
maximum throughput. The exact size of the run length varies based on the amount of variable 
coverage and element demographics (size and percentage of variable text vs. images/graphics). 
Perform regular disk maintenance to ensure trouble-free operation. 

Printing Retrieved VIPP jobs  
In order to print retrieved VIPP jobs the print range parameter must be deselected, otherwise the 
job might fail in print with the following message: “Job Failed in Print. Please try to resubmit the 
job”. After job RIPs, Print Range Booklets can be reselected. 

VI Job Thumbnails 
Do not attempt to view thumbnails with multi-record VI jobs, since no other job can be selected 
until these thumbnails have been generated on all the pages of the of the selected VI job. Do not 
open thumbnails for VIPP and/or VPS jobs that have been RIPed and are being held in the 
Storage folder, unless the user desires to view the thumbnails of the entire VI job. 

File Naming Convention 
Follow the naming conventions specified in the CXP3535 Printing Guide. Note that improper 
characters and file names with spaces may cause errors. For example: avoid using the following 
symbols: ! @ # $ % ^ & * ( ) - / ? > < ' " ; : ] [ { } \ |. This is relevant for image and job files. In some 
cases, the CXP3535 Color Server will substitute underbars ( _ ) in file names that contain the 
aforementioned characters. This will result in an inability to call out the Hi-Res image when using 
APR. It is recommended that all image files and the database file is scanned for these characters 
and fixed prior to creating any Darwin VPS file.  

VPS Image Files 
Supported file types utilizing the CXP3535 APR feature includes: EPS, TIFF, and CT. 

Print Shop Mail jobs 
VI elements in Landscape orientation of Print Shop Mail jobs will be processed and printed out in 
Portrait orientation. 
Print Shop Mail will only support EPS images. 
VPS that are generated from PS Mail v4.36 for Macintosh, and v4.1 ~build 72 for PC are not 
imposed correctly on the Spire 



13                                                                                                                  CXP3535 Version 1.0 for DC5252 

  

Application Notes 

Windows/office 
Custom page sizes cannot be defined in Microsoft Word for Windows NT and 2000. The value 
defaults back to A3 size.  

QuarkXPress 

In order to achieve good results in imposition using quark files in Custom Size and Landscape 
orientation, define the paper size as follows: 

• Document setup: Width = High value, Height =Low value 
• Print window: Width = Low value, Height = High value 
• PPD, Custom: Width = High value, Height = Low value 
To ensure validity of files, check the preview window in QuarkXpress before the postscript 
creation. 
In the printer driver window, Output tab; the only resolution option available is 300dpi, although 
the DocuColor 3535 will print the file in 600dpi. Disregard the resolution option setting. 

PageMaker 
• All operating systems enable the selection of transparency with custom paper size, 

although the printer can only print transparencies in A4 and Letter sizes. 
• All operating systems enable the selection of the custom paper size and Tray 1 or 2, 

although the printer can only print custom paper sizes from Tray 3 or 4. 
• Custom page sizes cannot be defined in PageMaker for the Macintosh operating system. 

The value defaults back to Letter size. If the image is larger than Letter, it will be cropped. 
• There are no error messages from the PPD when selecting the HCSS and Printer Default 

(Face Up) in PageMaker. Face down must be selected. 
• For PageMaker files with the Landscape orientation and Duplex Mode properties, Head to 

Head prints as Head to Toe, and Head to Toe, prints as Head to Head. 
• In PageMaker 6.5, there is no constraint from the PPD referring to "Face Down" and 

"collation=Yes" when choosing the stapler option. 
• The Admin Page with PageMaker prints incorrectly when selecting Staple from Macintosh. 

The first sheet of the job will be duplicated and printed instead of the Admin Page. 

Adobe Acrobat 
For PS files from Adobe Acrobat (PC version) in Duplex Mode, when the Head to Head option is 
selected the job prints as Head to Toe. 
For Adobe Acrobat files in Landscape orientation in Duplex Mode, when the Head to Head option 
is selected, the job prints as Head to Toe. 
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Freehand 
Admin Page does not print with Staple Jobs from Freehand. 

Adobe PS Known Limitations 
The following applications do not support all Adobe PS features. Usually the application simply 
ignores the feature, but in rare cases, a printing error may occur. 
 

Application Driver Feature 
Acrobat 5.05 

Mirror Image, Negative Image, Rotated Landscape 

CorelDraw 10.0 Scaling, Mirror Image, Negative Image 
Frame Maker 5.5 Rotated Landscape 
Freehand 9.0,10.0 N-up, Scaling, Landscape, Rotated Landscape, Mirror Image, 

Negative Image, Watermark, OpenType 
Illustrator 10 Euro, Watermark 
InDesign 2.0 Scaling 
PageMaker 7.0 N-up, Scaling, Rotated Landscape, Mirror Image, Negative Image, 

Watermark, Euro 
Photoshop 6.01 Watermark, Euro 
QuarkXPress 4.11 N-Up, Rotated Landscape, Mirror Image, Watermark, Euro 

 
Note: Some applications support Rotated Landscape only when it is set as the default from the 
Printers folder. 
 
Workaround: Do not use these AdobePS features when printing from the above applications. 
Newer versions of these applications may resolve these incompatibilities. 

 
 
 


